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Event Day Using Auctionpay Terminals

Welcome, and thank you for taking the time to listen to today’s training session. The 
purpose of today’s training is to help you get started using Greater Giving Event
Software PC and prepare for your Event Day. Let’s get started.
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Event Day Training
Agenda

1. Pre-event preparations

2. Running reports for guest registration

3. Overview of registration procedures

4. Entering winning bids

5. Correcting mistakes

6. Checking out

7. Post-event procedures and wrap-up

The training today will cover a number of topics. I’ll provide suggestions for 
preparing for your event and using your credit card equipment. I will also cover 
some recommended reports for expediting guest registration. I’ll walk you through 
the registration procedure using the Auctionpay Terminals, and then we will discuss 
the data entry portion, entering winning bids and correcting mistakes. Then I’ll cover 
the check-out and cashiering and provide suggestions to make check-out more 
efficient. Finally, I’ll discuss some post-event reports and walk you through wrapping 
up your fundraising event.
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Preparing for your Event

Up until the day before your event, or even Event day, if you have been working in 
Event Software Online, you will need to install Event Software PC.
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Where to find the software

Installing your Software

1. Go to www.greatergiving.com and click Support Center

2. Under Project Support and Training Center
click the Event Software icon

3. On the Resources tab, click Download the current version 
of Greater Giving Event Software – 4.1

To download the latest version of Event Software PC, in your web browser go to 
www.greatergiving.com. Click the Support Center button. Click the Event Software 
icon. Click Download the current version of Greater Giving Event Software 4.1.
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Software Download Login

To access the software, you’ll need to enter your login and password information, 
which can be found in the registration materials we provided for you. I recommend 
saving the downloaded setup file to a removable device, such as a thumb drive, so 
you can install the software directly to each computer. 

5



6

Stand-alone:
Both the program files and 
data center are installed 
under one parent folder

Network Server and Client:
The program files and the 
data center are installed in 
separate folders

Network Client only:
Only program files are 
installed 

If you are going to be using the software on one computer at your home or office, 
you would need to install the Stand-alone version. Network Server and Client and 
Network client only is for event day, when you need to set up a PC network to run 
your event.
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This is an example of a network installation.  The first computer is installed at 
the “Network Server and Client” and the subsequent computers are installed as 

“Network Client Only”.  

Support Facts:
Greater Giving provides support for all software related questions & needs.  

For all computer hardware questions & needs, please consult an IT 
professional for assistance.

This is an example of a network installation. The first computer is installed as the 
Network Server and Client and the subsequent computers are installed as Network 
Client Only.



8

Getting your Event Software Online 
project into Event Software PC

Once the software is installed, Next, you will need to download your database into 
Event Software PC. This is only for the Event Software Online users.
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Pre-Event Preparations

Download your Event Software Online project.

1. In the File menu, click Project 
Home.

2. Click the All tab.

3. Click Get projects from web.

4. Enter a Event Software Online 
username and password with 
organization admin rights.

5. Highlight the project and click 
Select Project.

6. You can overwrite an existing 
project or download the online 
project as a new project.

For Event Software Online users, you can download your online database directly 
from Event Software PC for use at your event using the window shown here. 
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Download your online database

We will walk through those steps. To download your database, go to File and click 
Project Home. 
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Download your online database

Go to the All tab and click Get Projects from Web. Enter your Greater Giving 
Online username and password. This login must have organization administrator 
rights in order to download the database.
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Download your online database

All available online projects will appear with a red and yellow arrow icon as shown 
here, select the database you wish to open and click Select Project. 
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Bringing down again – no merging

You may choose to overwrite an open database or open it as a new database. Just
to note, if you bring a copy down to train with or for testing, you can download a 
fresh copy of your online database (and overwrite any changes made offline) at any 
time by checking Download a fresh copy on the right. Once you have downloaded 
your final event database the morning of your event, please do not make additional 
online changes.
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Terminals vs. Card Readers

We offer two options for taking credit cards at your event.  Terminals or Card 
Readers.
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Requirements:
• Each device needs to have its own 

power source (2 amps each)
• If using with Software, must install 

the USB Driver (included in the 
box that we send terminals)

• Must have an analog phone line to 
submit payments

Benefits:
• Can be used with or without  

software (laptops)
• Can print its own receipt

Terminals

Terminal Requirements: Each device needs to have its own power source of 2 amps each. You will need to install the USB 
Driver that will be included in the box of terminals we send. And you will need an analog phone line to submit payments after your event. The 
benefits of using terminals: Can be used with or without software or computers. Can print its own receipt.
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Requirements:
• The most up-to-date Event Software 

PC on all computers
• Networked computers (server and 

client)
• One USB port needed to connect 

Card Reader to your PC
• At least 1 printer at the event (since 

the only copy of receipt must be 
printed)

• New EPS/EPCR Code for each event

Card Readers

Benefits:
• No additional power source 
needed
• All information for event is held in 
1 place
• Payment submission is through 
the internet

Card Reader Requirements: The most up-to-date Greater Giving Event Software on 
all computers. Networked computers (server and client). One USB port needed to 
connect Card Reader to your PC. At least 1 printer at the event. You can only print 
receipts from the software. New EPS EPCR Code for each event. The benefits of 
using Card Readers: No additional power source is needed. All information for your 
event is stored in one place. Payment submission is through the internet.
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Best Practices
Recommended:

1 device per 100 guests (either Card Readers or Terminals)

Card Readers – need to combine registration and check out areas

Card Readers – only 1 Card Reader per PC

Terminals – Separate registration and check out areas (registration on the first 
floor & check out on the second floor)  – you will not need to move and re-
networking computers.

Best Practices that we recommend: One device per 100 guests. With Card 
Readers, you need to combine registration and check out areas and you can  only 
have 1 card reader per computer. If you are having separate areas for registration 
and check out, for instance registration on the first floor and check out on the 
second floor, we recommend you use terminals so you will not need to move and 
re-network your computers.
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Registration / Check In

Next, I will go over the Registration and Check-in process.
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Running Reports for Guest 
Registration

The following are some of the most useful 
reports for handling registration:

• BID-01: Guest listing – Provides a detailed guest list.

• BID-02: Guest listing (2-column) – Provides a concise 
guest list.

• GRP-01C: Group listing – Lists guests by table group.
To access this report, go to View > Grid Views > Groups.

• UTL-05: Utility – Blank bidder registration forms
You can find all utility forms under File and Print General Report…

Here are some useful reports for making guest registration quick and painless. The 
Guest listing report provides a detailed guest list, including information like meal 
choice, table, group, mailing address, admission information, and more. The Guest 
listing (2-column) report is a more concise guest listing. The Group Listing report 
is accessible from the Bidder tab or the Group view, and lists your guests by table 
group. Finally, the Blank bidder registration forms report is useful for collecting 
information for guests who did not pre-register. You can find more blank forms 
under File and Print General Reports.

19



20

Running Reports for Guest 
Registration

Use reports to streamline registration.

• To run a report, choose the appropriate tab 
in the Query Bar. (e.g., bidder reports from 
the Bidder tab or package reports from the 
Package tab.)

Use Reset to 
clear all fields 

before querying.

• Filter your report 
using the fields 
and click Query.

• In the File menu, 
click Print 
Report

Now I will discuss some recommended reports for streamlining guest registration at 
your event. To run a report, such as the Guest Listing report, choose the 
appropriate tab. For example, to run the Guest listing report, choose the Bidder
tab on the Query bar. Filter your report using the fields and click Query when 
finished. For the Guest Listing, I recommend using the Include only bidders who
filter bar. Choose Have Seats Used and click Query to search for all bidders 
attending your event. If your results do not come up as you expect, try clicking 
Reset before applying your filters. Finally, go to File and Print Report, and choose 
the appropriate report from the list.

20



21

Check-in

1• Discuss payment 
options with guest

• Swipe card
• Express Checkout

2 • Enter bidder #

3 • Print guest receipt

Auctionpay terminals are set up near or at the check-in or registration tables. Begin the 
registration process by offering to swipe your guest’s card for convenience at the event. 
Many regular charitable event goers are already familiar with Express Pay and will be 
glad to swipe a card ahead of time. Others can wait until the end of the night to pay if 
they choose. After the guest’s card is swiped, you will enter the bidder number twice, for 
verification purposes. This links the credit card data to the bidder number. Then the 
terminal prints 2 receipts, a merchant copy and a customer copy. The guest signs the 
first receipt, the merchant copy.  Note the balance shows zero dollars because they have 
not purchased anything yet. And the detail on the receipt explains, “Your credit card will 
only be charged if you make any purchases. By signing below, you agree to pay the 
amounts associated with your purchases.” The guest signs a receipt and receives a 
copy, eliminating the need to see the Cashier at the end of the event. All credit card 
information is securely stored in the Auctionpay terminals. Once everybody is checked 
in, you can now close registration and run some valuable reports.
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After Check-in

4 • Run credit, totals and 
bidder reports 5

6

• Print and review reports

• Move master terminal to cashier

At the close of registration, we recommend that you print and review 3 reports from the 
Auctionpay terminal: credit, bidder, and totals. The Credit Report is a paper back-up that 
shows the guest’s name, credit card number and bidder number, and should be placed 
in a safe and secure location, like a cash box. The Bidder Report identifies who has pre-
swiped their card. The Totals Report is a double check of information. It can be run after 
Registration to confirm the number of guests who have pre-swiped their credit card. 
Once you’ve reviewed all the necessary reports from registration, you would then move 
the master Auctionpay terminal to cashiering.
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Sync Between Terminals and 
Event Software PC

• After registration, 
import express 
bidders from 
Auctionpay 
terminals

1

2 • After check-out, 
export bidder 
amounts to 
Auctionpay 
terminal 3 • After settlement, send 

bidder payments from 
Auctionpay terminals into 
Event Software PC

Day of Event Post Event

There are three easy steps to sync between the event software and the Auctionpay 
terminals. Sync 1: After swiping cards at registration, plug in and pass information to 
Event Software PC. Enter winning bids into Event Software PC during the event. Collect 
final payments and print receipts to finish the night out. Sync 2 and 3 happen after the 
event, back at the office.  For Sync 2, plug-in to sync winning bid amounts with credit 
cards. Credit cards are now assigned amounts to send to the bank. For Sync 3, 
reconcile with the bank and transfer final payment information back to your database to 
close out all your bids. Credit cards that did not go through will be flagged.
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Event Night - Express 

Checkout

– Sync 1

First, we will walk through sync one, which should happen after the registration and 
check-in portion of your event is over. Install the USB driver CD that was 
included in the box of terminals and reboot your computer. We recommend 
doing this before your event gets started. After registration closes, connect the 
Master terminal to the server computer using the sync cable provided, making 
sure to also disconnect from the network of terminals. Ensure the Master 
terminal is on the main screen. From the Event Software PC menu bar, select 
Data, then Synchronize with an Auctionpay terminal. 
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Sync 1

When the Sync Wizard dialog box displays, select Sync 1, then click Next, Next, 
and Finish.  Once the import is complete, remove the sync cable from the 
terminal and reconnect the Master terminal to the network of terminals to use at 
cashiering. Notice that Sync 1 can be performed as many times as needed. 
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Sync 1
After running sync 1:

Express Checkout: YES

Express Checkout: NO

After completing sync one, if a bidder has pre-swiped a credit card on the bidder 
info tab, it will show Express Checkout Yes. If they have not pre-swiped, it will show 
Express Checkout No.
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Data Entry / Sale Entry
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Entering Winning Bids

As your auctions close, enter the winning bid information in 
the F8 Sales Bar on the Sales tab.

Enter the package 
number or name 
and press Enter.
This auto-populates 
the package 
information here.

Enter the winning 
bidder (by name or 
number), the final sale 
price and click Sell.

Registration is over and your silent auction rooms have started to close. To enter 
the winning bid information, also known as the data entry phase, open the F8 Sales 
Bar and choose the Sales tab. Using the bid sheet, enter the package number or 
name and press Enter. This automatically fills in the rest of the package 
information. Then enter the winning bidder number and press Enter to populate the 
bidder information. Type the final sale price and click Sell. You can use Enter or 
Tab to move from field to field anywhere in the Sales Bar.
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Entering Winning Bids

You can also sell multi-sale packages such as 
raffle tickets, walk-in admission, and more.

1. In the F8 Sales 
Bar, click the 
Multi-Sales tab 
and select the 
multi-sale package 
you wish to sell.

2. Enter the bidder 
number or name 
and press Enter to 
populate.

3. Enter the quantity sold and press 
Enter to calculate the sale price.

4. Click Sell.

A multi-sale package can be sold multiple times. Multi-sale packages have a set 
sale price instead of a minimum bid. If you have sold any multi-sale packages at 
your event, such as raffle tickets, walk-in admission, or t-shirts, enter them in the 
Multi-Sale tab of the F8 Sales Bar. From the MS Package drop-down list, select 
the package to sell. Enter the bidder information and press Enter, then enter the 
quantity, press Enter again, and click Sell. Using Enter will automatically calculate 
the total sale price. You can always override the sale price manually. This is helpful 
if you sell your multi-sale packages in bulk at a discounted price. For example, 3 
raffle tickets for $15.
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Making a Multi-Sale 
Package

If you haven’t already created your Multi-Sale packages, in the Data menu, click 
New Package. Fill in the package number, and the package name. Make sure to
click the Multi-Sale box. Finally, go to the Bid Sheet Values area and check the 
box to override bid sheet values and update the Price field to the price that you 
would like to charge per sale. Once set up, press F10 to save or F11 to save and 
create another multi-sale package.
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Cashiering / Check Out
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Checking Out

1. To print receipts for all bidders who made 
purchases at your event, in the Query 
Bar, click the Bidder tab.

2. Enter 1 in the first box next to $ Spent.

3. Click Query.

4. In the File menu, click Print Report. 
(Optionally use CTRL + P or click the 
printer icon.)We only want to print 

receipts for bidders 
with purchases.

Speed up your check-out process by printing 
all receipts at one time.

You can filter any report this way.

We have entered all our sales and now we will start discussing check out. You have 
two options for printing bidder receipts. You can print all of them at one time using 
batch mode printing, or you can print receipts for each bidder when they check out. 
First, we will discuss how to print all receipts in a batch. Printing bidder receipts 
before check-out begins is a great way to streamline cashiering at the end of the 
night. To print receipts for all bidders that made purchases at your event and avoid 
printing receipts with no sales, choose the Bidder tab of the Query bar on the left-
hand side. If the Query bar is hidden, press F7 to display it. Enter the number 1 in 
the first box next to Dollars Spent and click the Query button. With the bidder grid 
displayed, go to File and Print Report. Remember that you can filter any report this 
way.
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Checking Out

Speed up your check-out process by printing 
all receipts at one time.

• From the Select Report Output 
Type dialog, choose the BID-06: 
Receipts with settings dialog.

• Once you’ve printed your receipts the 
first time, you can choose BID-06a: 
Receipts with presets to skip the 
questions.

Any bidders that are not marked Express 
Checkout will need to swipe a card or 
provide an alternative form of payment.

In the report dialog, choose the Receipts with settings dialog report the first time 
you run your receipt to set up your receipt preferences. The next time you choose to 
print a receipt, the Receipts with presets report will remember your settings. Click 
Print to print a copy of the receipt for each bidder in the grid. Any bidders that are 
not marked Express Checkout on the receipt will need to provide some form of 
payment at cashiering. Anyone marked for Express Checkout can bypass 
cashiering and go directly to pick up their items because you have already collected 
a form of payment from them.
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Printing All Receipts 
at One Time

If you need more than one copy of each bidder receipt when you print them in batch 
mode, you just need to indicate that on the Print dialog box that opens when you 
click Print. This dialog box opens and under Number of copies enter the number 
of copies that you would like to print.
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Checking Out

Printing individual bidder receipts

1. In the F8 Sales Bar, click the Bidder Info tab.

2. Click Print 
Receipt to print 
the receipt, or 
click View 
Receipt to view 
the Bidder 
Purchases 
Form before 
printing.

To change the number of receipt copies 
printed by the software, in the File menu, 
click Properties and then click Reports. 
(The default is 2.)

You can also print receipts for individual bidders using the Bidder Info tab of the F8 
Sales Bar. Enter the bidder number or name and press Enter. Next to Action, 
select Print Receipt and click the action button (which now reads Print Receipt) to 
send a paper copy of the receipt directly to the printer. Select View Receipt from 
the action menu to view a list of purchases and payments. To change the number of 
copies of the receipt that print from the Bidder Info tab, go to File, Properties, and 
choose the Reports tab. It defaults to 2 copies, one for you and one for your guest.
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Checking Out

Entering other forms of payment

For guests who choose to pay by cash or check, go to 
the Payments tab of the F8 Sales Bar.

DO NOT enter payments for credit card charges submitted through the 
software. These are automatically generated during the banking process.

It’s time to collect payments. For guests who choose to pay by cash or check, 
choose the Payments tab of the F8 Sales Bar. Enter all cash and check payments 
in this tab. Simply fill out the bidder number, payment type, dollar amount, and click 
Pay. Remember, do not enter payments for credit cards here, even during 
cashiering. Payments for credit cards are automatically generated during the 
banking process. If you manually enter credit card payments, the associated cards 
will not be charged correctly.
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Correcting Mistakes

Replace, modify, or delete sales from the F8 
Sales Bar.

1. To replace a sale, go to the Sales
tab and enter the sold package 
number or name. Press Enter.

2. Enter a new bidder number and 
sale price and click Sell. 

• To modify a sale, enter a new sale 
price and click Sell.

• To delete a sale, simply delete the 
bidder number and click Sell.

After printing a bidder receipt, your guest may find errors or have questions about 
purchases listed on the receipt. To replace a sale of a package, or sell the package 
to a different bidder, choose the Sales tab of the F8 Sales Bar. Enter the package 
number and press Enter. The Sales Bar will fill in the winning bidder that was 
previously entered. To replace the sale, change the bidder number, press Enter, 
correct the sale amount if necessary, and click Sell. The software will prompt you to 
replace the existing sale or add a new one. You may sell packages to more than 
one bidder, you can split a package between bidders this way, or sell the same item 
multiple times if you have more than one. If you would like to modify the sale price 
of an existing sale, bring up the sale the same way, change the sale price and click 
Sell, then click Replace to remove the old price and enter the new one. To delete a 
sale, enter the package number and press Enter to view the current purchaser. 
Delete the bidder number from the box and click Sell. The software will prompt you 
to delete the sale. Click Continue to remove the sale.
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Correcting Mistakes
You can also view and delete sales from the 
Bidder Purchases Form.

• In the F8 Sales Bar, click 
the Bidder Info tab and
click View Receipts to 
view the Bidder 
Purchases Form.

• To delete a sale, select the 
sale under Purchases and 
press the Delete key on 
your keyboard.

Additionally, you can view and delete sales from the Bidder Purchases Form. 
From the F8 Sales Bar, choose the Bidder Info tab. Next to Action, choose View 
Receipt, and click the action button to bring up the Bidder Purchases Form. Here 
you can add or delete sales listed in the Purchases grid or payments listed in the 
Payments grid using the Insert and Delete keys on your keyboard. Credit card 
payments pending submission are listed in the Credit Card Charges to be 
Submitted grid. To view or edit credit cards on file, click the View Edit Cards
button.
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Event Wrap-up
Back up your database and run final event 
reports.

• At the end of your event, in the Utilities menu, click Backup Database to 
secure all of your event data and remove it from the event site.

• Here are some common post-event reports:

BID-03: Sales listing by supporter – Details purchases by bid number.

PKG- 03: Sales listing by package with buyers – Lists package sales by 
package number.

PAY-02: Payment totals by type – Event revenue.

SUM-13: Summary – sales totals by pkg. sorted by amount and SUM-14: 
Summary – sales totals by bidder sorted by amt. rank highest-grossing 
bidders and packages.

You can access SUM reports: in the File menu, click Print General Reports.

Your event is over and your guests have gone home. Now it’s time to back up your 
database, run some final event reports to congratulate yourself on a job well done, 
and head home as well. To back up your database to your removable media, such 
as a memory stick, close all open grid views and go to Utilities, then select Backup 
Database. Some common event reports are the Sales listing by supporter, which 
details all purchases by bidder number, the Sales listing by package with buyers, 
which lists package sales by package number, the Payment totals by type, which 
displays your event revenue by payment type. The Summary sales totals by 
package sorted by amount and the Summary sales totals by bidder sorted by 
amount reports rank your highest-grossing bidders and packages. Summary 
reports are accessible by going to File and Print General Report. The summary 
reports are also helpful during your event to stir up excitement by capitalizing on 
high-bidding guests and luxurious packages.
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Sync Between Terminals 
and Event Software PC

• After registration, 
import express 
bidders from 
Auctionpay 
terminals

1

2 • After check-out, 
export bidder 
amounts to 
Auctionpay 
terminal 3 • After settlement, send 

bidder payments from 
Auctionpay terminals back 
to Event Software PC

Day of Event Post Event

After the event, most likely back at the office the next day, you will need to complete a 
Sync 2. Connect the master terminal to the server computer to sync winning bid dollar 
amounts with credit cards. Credit cards are now assigned amounts to send to the bank.
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1• Enter in final amount to bill each 
guest by bidder number (manually 
or through event software sync)

2

3

• Transmit batch with simple upload via 
phone line and review settlement report

• Auctionpay transmits 
funds into client account 
within 5 business days

Reconciliation and Settlement

Sync 2

Settlement with Auctionpay is very straight-forward. Our goal is to get your funds into 
your account as quickly as possible! Here’s how it works. We recommend doing this 
the next business day. Double check all entered winning bids for errors in the 
software, comparing against bid sheets and runner sheets. When you agree with 
everything that was entered in the software, it is time to Run Sync 2.
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Event Night - Express 

Checkout

– Sync 2

Ensure all winning bids are posted, and cash and check payments are entered into 
the software prior to performing Sync 2. No card payments should be entered into 
the software. This will be done during Sync 3. First, power up and connect the 
master terminal to the computer with the sync cable provided. From the Event 
Software PC menu, select Data, then Synchronize with an Auctionpay terminal. 
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Sync 2

In the Sync Wizard dialog box, select Sync 2, then click Next, Next, and Finish.  
Ensure the final purchase amounts are correct by auditing the bidder totals. This 
can be done by comparing a Credit Report from the Master terminal to the “BID-
03: Sales listing by bidder” report run from the bidder grid in the software.  If a 
dollar amount needs to be changed in the Master terminal, this can be corrected 
with the Adjustment function before sending charges to the bank. Notice that Sync 
2 can be performed multiple times as needed. 
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Send to Bank

1. 2.

3.

Charges are sent from the Auctionpay Master terminal to the bank for processing by using the Send 
to Bank function. Power up the Master terminal. Insert the provided phone cord into the LINE port in 
the back of the Master terminal. Insert the other end of the phone cord into a dedicated analog phone 
line. On the terminal press Tools, More, and Send to Bank. For “Upload Now?” press Yes. For “Do
you need to dial 9 or other prefix?”, press Yes or No as appropriate and follow the prompt. The 
terminal will next prompt “Correct?” with the total amount to be transmitted. Press Yes or No as 
appropriate. If No is selected because the total is incorrect, the charges will not be sent to the bank. 
Upon selecting Yes, the terminal will begin transmitting payment transactions. Once the transmission 
is complete, the terminal will generate a Banking report showing all approved and declined charges.
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Sync Between Terminals and 
Software

• After registration, 
import express 
bidders from 
Auctionpay 
terminals

1

2 • After check-out, 
export bidder 
amounts to 
Auctionpay 
terminal 3 • After settlement, send 

bidder payments from 
Auctionpay terminals back 
to Event Software PC

Day of Event Post Event

After the terminal generates the Banking report showing all approved and declined 
charges, it is time to run sync 3.  Yes, you need to run sync 3 before dealing with any 
declined charges. Remember Sync 3 transfers the final payment information back to 
your database to close out all your bids. Credit cards that did not go through will be 
flagged.
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Event Night - Express 

Checkout
– Sync 3

Power up and connect the Master terminal to the server computer with sync cable 
provided. From the Event Software PC menu, select Data, then Synchronize with 
an Auctionpay terminal. 
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Sync 3

In the Sync Wizard, select Sync 3, then Next, Next, and Finish. Note, Sync 3 can 
only be performed once (unless you are syncing with multiple Masters). After 
completing sync 3, see if you have any declines, which take place when the bank 
does not approve a charge. There are two options for handling declines. You can 
resubmit the charge using the method described in your orange quick start guide 
provided, or you can obtain an alternate form of payment from the guest. Once the 
batch has been uploaded, Auctionpay transmits funds into your account within 5 
business days. You would then return the terminals in the packaging that 
Auctionpay provides and drop it in the mail. 
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Event Wrap-up

Synchronizing your database with Event 
Software Online
• Once all outstanding balances 

are resolved, in the Data menu, 
click Synchronize with Online 
Project to send your event 
information to Event Software 
Online.

• After the sync, a summary of 
uploaded data appears.

The synchronization will fail if you 
have any credit card charges 
awaiting submission.

For those users that originally downloaded the event night database from Event 
Software Online, you can upload your new data back online using the 
synchronization tool. Once all outstanding credit card charges are submitted, go to 
Data and select Synchronize with Online Project. After the synchronization is 
complete, a summary of uploaded data will appear. Keep in mind that the 
synchronization will fail if you have any credit card charges to be submitted.
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Greater Giving Support

► Call Client Services at: 1-866-269-8151

Monday-Friday: 6:30 am – 5:00 pm PT

After-hours support is available for 
event night only at the same number.

► Email: support@greatergiving.com
Questions are answered within 1 business 

day.

► Visit our website at www.greatergiving.com

If you have any questions, feel free to give us a call at 1-866-269-8151 
or email us at support@greatergiving.com. Emailed questions are 
answered within one business day. Our phone support line is available 
for general inquiries Monday through Friday, 6:30 AM to 5:00 PM Pacific 
Time. After-hours support is available for organizations on event night 
only. For resources regarding the terminals or Event Software PC, visit 
www.greatergiving.com and click on the Support Center. Thank you. 
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